
If you want control … you need the right connections

“ErgoTorq”TM

Patented products,specifically designed to provide solutions to pulse 
and nutrunner assembly tooling Safety, Ergonomic, Quality, Reliability

and Cost Down problems. 

Guided Extension                 
“Collar”

“Ultralite” extensions 

weigh up to 50% less

Standard                                
“PinchPoint Protector”

Pulse tool guided 
quick change 
“Adapters”

Pulse tool Guided  
Sockets & Socket 

“Adaptors”

Superior selection, performance and delivery, at reduced cost ! 

“2008” Product Catalog

“Dual-drive” Socket                 
Allows you to rundown two different  
size fasteners with the same socket. 

“One-piece”
Pulse tool guided extensions 

& extended sockets

Safety & Anti-mutilation Covers

“ErgoTorq”TM

Assembly Tooling 
Accessories

“Non-rotating” Cover

“Slip Type” Cover

“Non-rotating/Retractable”        
Bit Holder Cover

NEW !

Durability 
tested to 
100,000 
cycles !



Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s

“ErgoTorq” 
“Guided” Pulse Tool Extensions 

(U.S. Patent #6,321,855) 

 

Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s

3/8" Square Drive 1/2" Square Drive  

Atlas Copco Pulse Tool Part #'s
3/8" Square Drive 1/2" Square Drive 1/2" Square Drive 

Models - 10C, 10XS, 12XS

"Ultralite" Pulse Tool Extensions ... Up to 50% lighter then standard extensions !!!

"Standard Weight" Pulse Tool Extensions

(*)Fuji models with exposed anvil behind square drive of > .385"

3/8" Square Drive 1/2" Square Drive 

Atlas Copco Pulse Tool Part #'s

3/8" Square Drive 1/2" Square Drive 
Models - 12X, 14X, 14XS, 10PT/PTS, 12PT/PTS Models - 10C, 10XS, 12XS

* "Ultralite" extensions are available in virtually any length and drive end configuration.
(Simply ask your ErgoTorq Authorized Distributor for a quote.)

Models - 12X, 14X, 14XS, 10PT/PTS, 12PT/PTS

(*)Fuji models with exposed anvil behind square drive of > .385"

Models - 8C, 8X, 7XS, 8XS, 5,6,7 & 8 PT/PTS

Models - 8C, 8X, 7XS, 8XS, 5,6,7 & 8 PT/PTS

A perfect match for 
either Aimco’s or 

Atlas Copco’s light 
weight pulse tools !

Length Part#
4" AR1EX3-4(1)
6" AR1EX3-6(1)
8" AR1EX3-8(1)
10" AR1EX3-10(1)
12" AR1EX3-12(1)

Length Part#
4" AR1EX4-4(3)
6" AR1EX4-6(3)
8" AR1EX4-8(3)
10" AR1EX4-10(3)
12" AR1EX4-12(3)

Length Part#
4" AR1EX3-4(2)
6" AR1EX3-6(2)
8" AR1EX3-8(2)
10" AR1EX3-10(2)
12" AR1EX3-12(2)

Length Part#
4" AR1EX4-4(5)
6" AR1EX4-6(5)
8" AR1EX4-8(5)
10" AR1EX4-10(5)
12" AR1EX4-12(5)

Length Part#
4" AR1EX4-45a)
6" AR1EX4-6(5a)
8" AR1EX4-8(5a)
10" AR1EX4-10(5a)
12" AR1EX4-12(5a)

Length Part#
4" AR1UEX3-4(1)
6" AR1UEX3-6(1)
8" AR1UEX3-8(1)
10" AR1UEX3-10(1)
12" AR1UEX3-12(1)

Length Part#
4" AR1UEX4-4(3)
6" AR1UEX4-6(3)
8" AR1UEX4-8(3)
10" AR1UEX4-10(3)
12" AR1UEX4-12(3)

Length Part#
4" AR1UEX3-4(2)
6" AR1UEX3-6(2)
8" AR1UEX3-8(2)
10" AR1UEX3-10(2)
12" AR1UEX3-12(2)

Length Part#
4" AR1UEX4-4(5)
6" AR1UEX4-6(5)
8" AR1UEX4-8(5)
10" AR1UEX4-10(5)
12" AR1UEX4-12(5)

Length Part#
4" AR1UEX4-4(5a)
6" AR1UEX4-6(5a)
8" AR1UEX4-8(5a)
10" AR1UEX4-10(5a)
12" AR1UEX4-12(5a)

Superior selection, 
performance and 

delivery then either 
Aimco ergo-drive or 

Atlas Copco extensions 
at reduced cost !

1/2" Square Drive 

Durability tested to 100,000 cycles !



“ErgoTorq” 
“Guided” Pulse Tool Sockets & Accessories 

(U.S. Patent #6,321,855) 

 A low cost, high quality alternative to Aimco/Uryu and Atlas Copco pulse tool accessories !!!

Pulse Tool 6 Point Standard Length Sockets

3/8" Square Drive Standard 3/8" Square Drive Metric 1/2" Square Drive Standard 1/2" Square Drive Metric

Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s
(*)Fuji models with exposed anvil behind square drive of > .385"

Atlas Copco Pulse Tool Part #'s
3/8" Square Drive Standard 3/8" Square Drive Metric
Models - 8C, 8X, 7XS, 8XS, 5PT/PTS

1/2" Square Drive Standard 1/2" Square Drive Metric 1/2" Square Drive Metric1/2" Square Drive Standard

Models - 8C, 8X, 7XS, 8XS, 5PT/PTS
6PT/PTS, 7PT/PTS, 8PT/PTS6PT/PTS, 7PT/PTS, 8PT/PTS

Models - 12X, 14X, 14XS, 10PT/PTS,
12PT/PTS

Models - 10C, 10XS, 12XS Models - 10C, 10XS, 12XSModels - 12X, 14X, 14XS, 10PT/PTS,
12PT/PTS

* Virtually any standard 3/8”, 1/2” & 3/4” drive attachment is available in pulse tool format.
(Simply ask your ErgoTorq Authorized Distributor for a quote.)

Pulse Tool Quick Change Adapters
Uryu / Aimco Pulse Tool Part #'s

(*)Fuji models with exposed anvil behind square drive of > .385"
3/8" Square Drive 1/2" Square Drive 3/8" Square Drive 1/2" Square Drive

Virtually any 
accessory is 

available for all 
manufacturers 

pulse tools !

Atlas Copco Pulse Tool Part #'s

Fastener Size Part#
3/8" AR3112(1)
7/16" AR3114(1)
1/2" AR3116(1)
9/16" AR3118(1)
5/8" AR3120(1)

11/16" AR3122(1)
3/4" AR3124(1)

13/16" AR3126(1)

Fastener 
Size Part#

10mm AR10mm13(1)
11mm AR11mm13(1)
12mm AR12mm13(1)
13mm AR13mm13(1)
14mm AR14mm13(1)
15mm AR15mm13(1)
16mm AR16mm13(1)
17mm AR17mm13(1)

Fastener 
Size Part#
3/8" AR3112(2)
7/16" AR3114(2)
1/2" AR3116(2)
9/16" AR3118(2)
5/8" AR3120(2)

11/16" AR3122(2)
3/4" AR3124(2)

13/16" AR3126(2)

Fastener 
Size Part#

10mm AR10mm13(2)
11mm AR11mm13(2)
12mm AR12mm13(2)
13mm AR13mm13(2)
14mm AR14mm13(2)
15mm AR15mm13(2)
16mm AR16mm13(2)
17mm AR17mm13(2)

Fastener 
Size Part#
1/2" AR5116(4)
9/16" AR5118(4)
5/8" AR5120(4)

11/16" AR5122(4)
3/4" AR5124(4)

13/16" AR5126(4)
7/8" AR5128(4)

15/16" AR5130(4)
1" AR5132(4)

Fastener 
Size Part#

12mm AR12mm15(4)
14mm AR14mm15(4)
16mm AR16mm15(4)
18mm AR18mm15(4)
19mm AR19mm15(4)
20mm AR20mm15(4)
22mm AR22mm15(4)
24mm AR24mm15(4)
25mm AR25mm15(4)

Fastener 
Size Part#
1/2" AR5116(5)
9/16" AR5118(5)
5/8" AR5120(5)

11/16" AR5122(5)
3/4" AR5124(5)

13/16" AR5126(5)
7/8" AR5128(5)

15/16" AR5130(5)
1" AR5132(5)

Fastener 
Size Part#

12mm AR12mm15(5)
14mm AR14mm15(5)
16mm AR16mm15(5)
18mm AR18mm15(5)
19mm AR19mm15(5)
20mm AR20mm15(5)
22mm AR22mm15(5)
24mm AR24mm155)
25mm AR25mm15(5)

Fastener 
Size Part#

12mm AR12mm15(5a)
14mm AR14mm15(5a)
16mm AR16mm15(5a)
18mm AR18mm15(5a)
19mm AR19mm15(5a)
20mm AR20mm15(5a)
22mm AR22mm15(5a)
24mm AR24mm15(5a)
25mm AR25mm15(5a)

Fastener 
Size Part#
1/2" AR5116(5a)
9/16" AR5118(5a)
5/8" AR5120(5a)

11/16" AR5122(5a)
3/4" AR5124(5a)

13/16" AR5126(5a)
7/8" AR5128(5a)

15/16" AR5130(5a)
1" AR5132(5a)

Hex 
Drive Part#
1/4" ARQR-308(1)
7/16" ARQR-314(1)

Hex 
Drive Part#
1/4" ARQR-508(4)
7/16" ARQR-514(4)
5/8" ARQR-520(4)

Hex 
Drive Part#
1/4" ARQR-308(2)
7/16" ARQR-314(2)

Hex 
Drive Part#
1/4" ARQR-508(5) or (5a)
7/16" ARQR-514(5) or (5a)
5/8" ARQR-520(5) or (5a)

Any socket can be 
fitted with our        

“Slip-Type”       
Anti-mutilation 
Safety Covers !



“Adaptors” for Uryu Pulse Tools > Apex Sockets
Tool Type * Socket - Drive End O.D.  "ErgoTorq" Part #'s

3/4"(.750")(QR308) AR06A(1)
13/16"(.813") AR07A(1)

7/8"(.875") AR08A(1)
3/8" Square Drive > 15/16"(.938")  = AR09A(1)

1"(1.000") AR10A(1)
1-1/16"(1.063") AR10A2(1)
1.113"(QR314) AR10A1(1)
1-1/8"(1.125") AR11A(1)
1-1/4"(1.250") AR12A(1)

0.925" (QR508) AR12A1(4)
15/16"(.938") AR13A(4)

1"(1.000") AR14A(4)
1-1/16"(1.063") AR14A2(4)
1.113"(QR514) AR14A1(4)
1-1/8"(1.125") AR15A(4)
1-1/4"(1.250") AR16A(4)
1-5/16"(1.312") AR16A1(4)
1-3/8"(1.375") AR17A(4)
1-1/2"(1.500") AR18A(4)
1-5/8"(1.625") AR19A(4)

1/2" Square Drive > 1-3/4"(1.750")  = AR20A(4)
1-7/8"(1.875") AR21A(4)

1-15/16"(1.938") AR22A(4)
2"(2.000") AR23A(4)

2-1/8"(2.125") AR24A(4)
2-1/4"(2.250") AR25A(4)
2-3/8"(2.375") AR26A(4)
2-1/2"(2.500") AR27A(4)

(U.S. Patent #6,321,855)

Tool Type Apex Extension Series
3/8" Square Drive > EX-376 (3/8") SeriesExtensions  = AR02A(1)
1/2" Square Drive > EX-508 (1/2") Series Extensions  = AR03A(4)

"ErgoTorq" Part #'s

ErgoTorq ”Socket Adaptors”
for Uryu Pulse Tools > Apex Accessories

“Adaptors” for Uryu Pulse Tools > Apex Extensions

Apex Extension Series * Socket - Drive End O.D.  "ErgoTorq" Part #'s
1/2"(.500") AR33A

9/16"(.563") AR34A
5/8"(.625") AR35A

11/16"(.6875") AR35A1
EX-250 > 3/4"(.750")  = AR36A

(1/4" square drive extension) 13/16"(.813") AR37A
7/8"(.875") AR38A
5/8"(.625) AR38A1
3/4"(.750") AR39A

13/16"(.813") AR40A
7/8"(.875") AR41A

EX-376 > 15/16"(.938")  = AR42A
(3/8" square drive extension) 1"(1.000") AR43A

1-1/16"(1.063") AR43A1
1-1/8"(1.125") AR44A
1-1/4"(1.250") AR45A
15/16"(.938") AR46A

1"(1.000") AR47A
1-1/16"(1.063") AR47A1
1-1/8"(1.125") AR48A
1-1/4"(1.250") AR49A
1-5/16"(1.312") AR49A1
1-3/8"(1.375") AR50A
1-1/2"(1.500") AR51A
1-5/8"(1.625") AR52A

EX-508 > 1-3/4"(1.750")  = AR53A
(1/2" square drive extension) 1-7/8"(1.875") AR54A

1-15/16"(1.938") AR55A
2"(2.000") AR56A

2-1/8"(2.125") AR57A
2-1/4"(2.250") AR58A
2-3/8"(2.375") AR59A
2-1/2"(2.500") AR60A

“Adaptors”  
easily convert 

any socket into 
an ergo guided 

pulse tool 
socket.

*PLEASE NOTE : To determine socket drive end O.D., check "C" dimensions in Apex catalogue.

“Adaptors” for Apex Extensions > Apex Sockets



Square Drive
A.C. Reaction Bar 

Nut Part#
"Collar"         
Part #'s

3/8" 4210 2135 00 AR200-S1

3/8" 4210 2135 00 AR200-S1T(telescoping)

3/8" 4220 1028 00 AR200-S3

3/8" 4210 1799 00 AR200-S4
1/2" 4210 2218 00 AR200-S2
1/2" 4210 2218 00 AR200-S2T(telescoping)

1/2" 4210 2135 00 AR200-S5

“ErgoTorq” 
 

 

 

"Ultralite" Standard Square Drive Extensions

3/8" Square Drive 1/2" Square Drive 

Durability tested to 
100,000 cycles !

Available in virtually 
any length and drive 

configuration !

Atlas Copco Nutrunner Guide Extension “Collar” Part #'s
Anglehead Tools Inline Tools

Square Drive
A.C. Front Nut # or 

Thread O.D.'s
"Collar"     
Part #'s

3/8" 4210 1877 00 AR200-A1

3/8" 4210 3349 00 AR200-A2

3/8" 4210 3349 01 AR200-A2(01)

3/8" 4210 3349 02 AR200-A2(02)

1/2" 4210 3349 03 AR200-A2(03)

3/8" 4210 3349 05 AR200-A2(05)

3/8" 4210 2492 00 AR200-A5

1/2" 4210 1140 00 AR200-A6

1/2" 4210 1141 00 AR200-A7

3/8" 4220 0791 00 AR200-A9

3/8" 4220 1994 00 AR200-A10 

1/2" M34 X 0.75 LH thread AR200-A10ET

1/2" 4220 1992 00 AR200-A11

1/2" M39 X 1.0 LH thread AR200-A11ET

3/8" 4210 3860 00 AR200-A12

1/4" 4210 4036 00 AR200-A13

1/4" 4110 1407 00 AR200-A14

3/8" 4220 1742 06 AR200-A15

3/8" 4210 4446 00 AR200-A16

3/8" M27 X 0.75 LH thread AR200-A17ET

3/8" 4810 3260 00 AR200-A18

1/2" M43 X 1 LH thread AR200-A19ET

1/2" M48 X 1 LH thread AR200-A20ET

Pistol Grip Tools
Square Drive

"Reaction Bar Nut" 
Part#

"Collar"         
Part #'s

3/8" 4220-1028-00 AR200-P2

1/2" 4210-2135-00 AR200-P3

Atlas Copco Nutrunner 
“PinchPoint Protector” Part #'s

Anglehead Tools
Inline Tools

Pistol Grip Tools

Square 
Drive

A.C. Reaction Bar 
Nut Part#

"PinchPoint Protector"  
Part #'s

3/8" 4210 2135 00 PP200-S1

3/8" 4210 2135 00 PP200-S1T(telescoping)

3/8" 4220 1028 00 PP200-S3

3/8" 4210 1799 00 PP200-S4
1/2" 4210 2218 00 PP200-S2

1/2" 4210 2218 00 PP200-S2T(telescoping)

1/2" 4210 2135 00 PP200-S5

Square 
Drive

A.C. Front Nut 
Part#

"PinchPoint Protector" 
Part #'s

3/8" 4210 1877 00 PP200-A1
3/8" 4220 1994 00 PP200-A10 *
3/8" 4210 3349 00 PP200-A2

3/8" 4210 3349 01 PP200-A2(01)

3/8" 4210 3349 02 PP200-A2(02)

3/8" 4210 2492 00 PP200-A5
1/2" 4220 1992 00 PP200-A11 *
1/2" 4210 3349 03 PP200-A2(03)

1/2" 4210 1140 00 PP200-A6
1/2" 4210 1141 00 PP200-A7

Square Drive
A.C. Reaction Bar 

Nut Part#
"PinchPoint Protector" 

Part #

3/8" 4220-1028-00 PP200-P2
1/2" 4210-2135-00 PP200-P3

To determine your “Collar” & Extension Part #, simply 
add required extension information in ( )’s after the 
“ErgoTorq” “Collar” Part#, using a 3 for 3/8” drive or 4 for 
1/2” drive and the length of extension.                   

Length Part#
4" AUEX3-4
6" ARUEX3-6
8" ARUEX3-8
10" ARUEX3-10
12" ARUEX3-12

Length Part#
4" ARUEX4-4
6" ARUEX4-6
8" ARUEX4-8
10" ARUEX4-10
12" ARUEX4-12

Developing Collar & Extension Part #’s

For extension lengths longer then 12”, simply ask for a quote.

To complete your “PinchPoint Protector” Part #, simply add a / and the three decimal place O.D. of the socket 
being used, and an (S) for “Standard” Example : PP200-A1/.750(S)

“Collar’s”
Can be fitted to 

virtually any 
manufacturers 
nutrunner tool !

“Standard” 
PinchPoint Protector

Example : Part#- AR200-A1(3-8) for a “Collar” and 3/8” X 8” extension.
For an Ultralite extension insert a U in front of the the drive size number. eg.(U3-8) 

Up toUp to 50% lighter50% lighter then normal extensions !then normal extensions !

(U.S. Patent #6,123,157)
Nutrunner Guided Extensions, & “PinchPoint Protectors”

Eliminate extension 
wobble, improve tool 

torque quality & 
reliability !

Eliminates the inherent 
pinchpoint that exists 

between the tool and its’ 
attachment!

Guided Extension 
“Collar”



“ErgoTorq” 
Tooling Attachment “Non-Rotating” and “Slip Type” 

““AAnnttii--mmuuttiillaattiioonn//SSaaffeettyy  CCoovveerrss””  
 

 

• eliminate the potential of “Product Mutilation”
defects caused by rotating tooling attachments 
coming into contact with finished surfaces

• are available in guided format for pulse tool 
applications or standard drive format for  
nutrunner type tools

• eliminate the “Rotating Shaft Safety 
Hazard” which can cause serious injuries to 
operators who are continually exposed to

• can be designed for use with various fastener 
sizes as well as our “Ultralite” extensions to 
meet the specific needs of the customer

“Non-rotating” Covers

“Slip Type” Covers

“Non-rotating/Retractable”        
Covered Bit Holders

• Patent Pending design allows tooling operators 
to rundown two different size fasteners with the 
same socket without having to handle the socket

• available in guided format for pulse tool 
applications or standard drive format for 
nutrunner tools

• can be designed for use on a wide range of 
various fastener sizes to meet the needs of the 
customer

• significant cycle time reductions can be 
achieved with this “NEW” innovative product !!!

“Dual“Dual--Drive” SocketsDrive” Sockets
* “Dual-drive” sockets  
are available in virtually 
any drive size and type 
configurations.
(Simply ask your ErgoTorq
Authorized Distributor for a quote.)

“NEW”
Dual-drive sockets 

will significantly 
reduce process 

cycle times !

¼”>1/2” dr. sockets & extension up to 12”

For ordering or product information, contact your local ErgoTorq distributor, call 
Ergonomics Specialties at (519) 425-2604, visit our web-site at www.ergotorq.com or 

e-mail us at ergotorq@execulink.com

NEW! 
“Non-Rotating” 

anti-mutilation & 
safety covers 

provide ULTIMATE
operator safety!

Ask your local Ask your local ErgoTorqErgoTorq Distributor for a quote or contact us directly !Distributor for a quote or contact us directly !

Fit  any
manufacturers 
attachments !


